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Cooke Publishing Company has provided you with 
the necessary supplies and pre-printed instructions 
to facilitate the preparation of your yearbook pages. 
However, we recognize that the technical aspects 
of preparation might need further clarification, and 
should be teamed with suggestions that will keep 
your yearbook current.

In the past we have prepared handouts and assem-
bled them into binders, commonly called our 
Adviser’s Manual. With ever-changing technology 
enabling us to prepare your yearbook more effi-
ciently, it becomes necessary to update instruc-
tions and procedures from time to time. This binder 
serves as our current Adviser’s Manual, and you 
should use it beginning September 1, 2009.

The enclosed instructions include methods for writ-
ing and stylizing copy and captions, as well as keying 
text on a computer. They include layout fundamen-
tals, as well as layout software instructions for Adobe® 
InDesign© and QuarkXPress®. They include photogra-
phy concepts, as well as cropping and saving specif-
ics for Adobe® Photoshop®. As well as much, much, 
more. There are sample forms for story and photo 

assignments, keeping track of deadlines, and gather-
ing directory information. There are cover ideas, sug-
gestions on developing your theme, and references 
to the Columbia Scholastic Press Association (CSPA) 
Guidelines. The Manual is prepared to answer your 
questions as well as consolidate some of our advice. 
Please read through this Manual thoroughly. The 
information here is not meant to replace our personal 
training, but to support it.

We suggest the following:

THROW AWAY YOUR OLD MANUAL. It has out-
of-date information in it.

READ this new Manual. Read it more than once to 
reinforce practices and procedures.

PHOTOCOPY and distribute portions of the 
Manual to the appropriate staff members, always 
keeping your master copy intact.

Call us if you have any questions about the new 
Manual.

Have a great year! Make a great book!

ABOUTour MANUAL
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 A yearbook theme is an idea, a thought, some 
specific words, a design, or a concept that unifies 
the publication. Unlike the student newspaper or 
literary magazine, the yearbook is a permanent 
record prepared by the staff, for one student body, 
organized to preserve information about the peo-
ple and events of one complete school year. This 
process is often helped by the selection of one 
theme statement that “ties together” the yearbook 
and makes it a cohesive, organized publication. 
 Although important as an organizing device, 
the theme is still secondary to the facts of the 
year. Popular themes use phrases that can work to 
describe the year and can be related to all of the 
various sections of the book. Pages devoted entire-
ly to the theme usually make up only ten to fifteen 
percent of the yearbook. The majority of pages in 
the yearbook are organized to present the people 
and events of the year. The theme statement should 
appear on the cover, on the endsheets if they are 
printed, title page, opening pages before the first 
divider, each divider, and in closing spreads. The 
statement is often accompanied by expressive pho-
tographs and text that connect the school, the year, 
and the statement.
 Special events and changes during the school 
year, like new construction, curriculum adjust-
ments, and anniversary celebrations are newswor-
thy, and should be featured in the yearbook. They 

can even double as the theme. Other times you 
can focus on contemporary theme ideas. You can 
start by observing the world around you differently. 
Make an idea file that has catchy magazine and 
newspaper advertisements, words, magazine lay-
outs, and colors. Anything that grabs your attention 
will probably grab the attention of your readers. 
Save junk mail. Good ideas prepared for consumer 
products by advertising agencies could work for 
you, too. We’re not recommending that you use 
their words outright. Yet, with the whole staff sit-
ting around a table covered with great advertise-
ments, phrases from magazines and catchy ideas, 
you are sure to have everyone thinking in a “stream 
of consciousness” and great ideas come from that 
kind of brainstorming.
 After selecting a theme statement, make a con-
nection to the various divisions of the yearbook. 
Plan essays, photographs and content that will 
look appropriate for each divider. Share your ideas 
and vocabulary words with us when you complete 
your Pagination Guide; we’ll be happy to provide 
you with feedback and advice on the preparation 
of these special pages.
 Lastly, visit chapter three on “Unifying Concept” 
in the CSPA Scholastic Yearbook Fundamentals. 
CSPA itemizes and expounds on both good and 
not-so-good theme ideas, slogans, terminology 
and gimmicks.

ThEME dEvELOpMENT
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• Oversee the preparation of the pagination plan, 
yearbook content and theme development.
• Work with the adviser to decide type style, folio 
design, the number of pages in the book, the num-
ber of pages in each section, point sizes of type, 
headline treatment, etc.
• Be responsible for the preparation of all theme-
related pages (opening, closing and dividers).
• Assign all pictures needed for theme-related 
pages of yearbook.
• Index all theme-related pages.
• Work with the adviser to set deadlines through-
out the year for the copy, captions, headlines, lay-
outs,  pictures, and pages assigned to each Cooke 
Publishing Company deadline.

• Be responsible for preparing the cover/endsheets.
• Oversee the work of all section editors and other 
staff members.
• Know all procedures so that you can answer 
questions, assist section editors and check staff 
progress.
• Conduct yearbook meetings and work sessions at 
any time the adviser is not present.
• Check all copy, layouts and pictures, approving 
them before the adviser sees them.
• Assist the adviser in proofreading all pages before 
they are submitted to your Cooke Representative.
• Check laser proofs carefully and return to Cooke 
Publishing Company by the date listed on the proof 
sheet.

EDItOR-IN-CHIEF

• Work with the adviser in preparing a budget for 
the yearbook.
• Prepare publicity for senior and underclass por-
traits, yearbook sales, ad sales, etc.
• Organize and assign all ads for staff members to 
sell.
• Prepare letters for advertisers who do not contin-
ue their ads in this year’s book, but who advertised 
last year.

• Prepare and mail letters for Senior Parent Patrons.
• Supervise billing of all advertisers.
• Supervise yearbook sales.
• Prepare letter for parents of all students who did 
not order yearbooks during regular sale days.
• Assist with any other business-related work as 
assigned by the adviser.
• Supervise yearbook distribution and check sales 
lists for each homeroom.

BUSINESS MANAGER

• Decide on the contents of the Academics section.
• Prepare all stories, headlines, captions and lay-
outs for the Academics section.
• Check with teachers to get picture and story 
ideas on special projects, guest speakers, field trips, 
unique classes, etc. This may be done in question-
naire form.

• Schedule all pictures needed for the Academics 
section.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Index all Academics pages.
• Check proofs of all Academics section pages 
when received from Cooke Publishing Company.

ACADEMICS EDItOR(S)

EdiTOrS’ rESpONSiBiLiTiES



We take everything personally

607 louis drive • warminster, pa • 18974 • phone: 215.957.2701 • fax: 215.957.2705

www.cookebooks.com

COOKE
PUBLISHING 
COMPANY

PAGE 5

• Supervise taking of senior portraits in the spring of 
their junior year. Several senior staff members will 
be needed to work with the photographer to fill out 
necessary paperwork for all seniors photographed.
• Supervise senior portrait make-ups after school 
starts. Prior to make -up day, all seniors not yet pho-
tographed must be notified and given the opportu-
nity to be photographed for the yearbook.
• Decide on any feature content for the Senior sec-
tion.
• Prepare all stories, headlines, captions and lay-
outs for the Senior section.
• Assign all pictures for use with features in the 
Senior section.

• Index all Senior section pages.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Prepare all faculty and service personnel pages.
• Decide on mini-features and prepare stories for 
faculty and service personnel pages.
• Make sure all faculty and staff are photographed 
when underclass portraits are taken or on a make-
up day.
• Index all Faculty pages.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Check proofs of all People/Senior/Faculty pages 
when received from Cooke Publishing Company.

PEOPLE/SENIOR AND FACULtY EDItOR(S)

CLUBS AND ORGANIzAtIONS EDItOR(S)

• Decide on the contents of the Clubs and Organ-
izations section.
• Prepare all stories, headlines, captions and lay-
outs for the Clubs and Organizations section.
• Check with Clubs and Organizations moderators 
to get picture ideas on special club projects, speak-
ers, inductions, etc. This may be done in question-
naire form.
• Schedule all pictures needed for the Clubs and 
Organizations section.
• Coordinate and schedule all Club and Organiz-
ation group pictures. Once preparations have been 
made for taking the group pictures, the Clubs and 
Organizations Editor must notify each Club and 

Organization moderator of the date, time and loca-
tion of the pictures. Do this in writing and follow 
up.
• Prepare Clubs and Organizations identification 
sheets for students to fill out when group pictures 
are taken, so that the Club and Organization mod-
erators will not have to identify members after pic-
tures are taken.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Index all Clubs and Organizations pages, includ-
ing group pictures.
• Check proofs of all Clubs and Organizations pages 
when received from Cooke Publishing Company.

• Supervise taking of all underclass portraits.
• Notify all students prior to portrait-make-up day 
if they must be re-photographed due to having eyes 
closed, improper clothing, etc.
• Supervise make-up day portraits.
• Decide on mini-features for the Underclass section.
• Assign all pictures needed for features in section.

• Prepare all stories, headlines, captions and lay-
outs for the Underclass section.
• Index all Underclass pages.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Check proofs of all Underclass pages when 
received from Cooke Publishing Company.

PEOPLE/UNDERCLASS EDItOR(S)
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• Receive all photo assignments from staff, record 
in assignment book, and put in photographers’ 
boxes.
• Record all completed assignments returned by 
photographers.
• Oversee all photographers to be sure they are 
completing the assignments for their sections. 

• Alert other yearbook editors of upcoming events 
and assign photographers to cover those events.
• Check the cameras, battery supply and memo-
ry cards regularly to avoid problems and missed 
photo opportunities.
• Establish a procedure for photographers to follow 
when placing digital photos on the computer. 

PHOtOGRAPHY EDItOR(S)

• Take all pictures assigned by staff members and 
the Photography editor.
• Complete daily assignments.
• Follow procedures for placing digital photos on 

the yearbook computer/server and provide a con-
tact sheet with initialed and dated assignment forms 
to the Photography editor.
• Work with other photographers to keep computer/
digital photo storage area organized.

PHOtOGRAPHERS

• Decide on the contents of the Sports section.
• Prepare all stories, headlines, captions, layouts 
and score boxes for the Sports section.
• Schedule the pictures for all sports, including 
a group picture of each team, cheerleaders and 
intramural sports.
• Identify players in all captions by including jer-
sey number in parentheses after his/her name.
• When possible, identify opposing players by 

name and jersey number in captions.
• Record the scores of all games, meets or matches 
to be used in a score box.
• Meet deadlines established by the editor-in-chief 
and adviser.
• Index all Sports section pages.
• Check proofs of all Sports section pages when 
received from Cooke Publishing Company.

SPORtS EDItOR(S)

student life.
• Meet deadlines established by the editor-in-chief 
and the adviser.
• Index all Student Life pages.
• Check proofs of all Student Life section pages 
when received from Cooke Publishing Company.

• Decide on the contents of the Student Life section.
• Prepare all stories, headlines, captions and lay-
outs for the Student Life section.
• Schedule all pictures needed for the Student Life 
section. Don’t forget to include summer activities, 
snow days and after-school activities relating to 

StUDENt LIFE EDItOR(S)
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 Think of all the places these companies advertise 
their products. They don’t put up one billboard and 
call it a day. They are constantly putting their names 
in your face. Turn on the TV or radio, open a maga-
zine, look at the side of the bus driving down the 
street. They adopt slogans and themes. They even 
advertise on shopping carts at the supermarket. Get 
the picture? Plan your yearbook sales campaign the 
same way. Get in your students’ faces and show them 
the comparative value of the yearbook. Compete 
head to head with other teenage expenses.
 Flyers and posters are probably the most popu-
lar way of advertising in schools (especially since 
the number of billboards in the hallways is limited). 
Flyers are great, but remember other organizations 
may be advertising candy sales or upcoming danc-
es at the same time. You want your flyer to stand 
out from the rest. How do you do that? You don’t 
scribble on a piece of paper with a marker and call 
that an advertisement! First, find someone who has 

a computer software program that will print flyers 
in large type (graphics would be nice, too). Prepare 
announcements that are attractive, legible, and can 
be read from a distance. Second, copy your flyers on 
brightly colored paper; white flyers may be ignored 
if they blend in with the walls. Third, don’t just put 
up one flyer on the wall or bulletin board; put up 
nine and make a large square (three rows of three), 
or place them every two feet down a long hallway. 
Students may walk by one flyer and not notice it, 
but how can they miss twenty in a row? Put them 
in unusual places. One school laminated their post-
ers and taped them to the floor in high traffic areas. 
Find interesting (and permitted) locations for your 
notices, like the back of bathroom stalls and next to 
the clocks in the classrooms.
 Posters can be an effective way to advertise, again, 
if they stand out. Decorate them with bright colors 
or glitter. Make them odd shapes. Don’t forget to use 
the posters we include in the supply box, too.

tHINK NIKE® AND REEBOK® – GEt ENDORSEMENtS

 OK, so superstar golfer Tiger Woods may not be 
in your budget, but how about the captain of your 
school’s basketball team? Recruit other students, 
athletes, cheerleaders, student council reps, the 
computer techies, even teachers to speak for your 
product. You need to appeal to everyone in your 
school, not just seniors and not just the most active 
or popular students. Having other students sell the 
yearbook shows that the book isn’t just for the year-
book staff and their friends. It may also place some 
positive peer pressure on the student body – if the 

basketball captain wants a yearbook then they will 
want one, too.
 So how and where are these spokespersons going 
to get the word out? Just like Tiger. Tape a commer-
cial for the morning announcements on the home-
room television station, or write a creative script 
for the afternoon public address announcements. 
Take your spokesperson’s picture and add it to the 
decorative posters you are making. Have them go 
table to table in the cafeteria like a door-to-door 
salesman.

SELLiNg the yEArBOOk
tHINK COCA-COLA® AND PEPSI®, VERIzON® AND At&t®,
tACO BELL® AND DUNKIN’ DONUtS® – SAtURAtE YOUR AUDIENCE
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tHINK PUBLISHER’S CLEARING HOUSE® – PERSONALIzE LEttERS

 Your yearbook sales campaign ran for two weeks 
and you sold to 60% of the student body. Do you 
stop there? Of course not. Examine the list of stu-
dents who did not purchase books. For the next two 
weeks concentrate on those students. Send each 
non-buying student a personalized, hand-written 
note in homeroom, “John, we noticed you did not 
buy a yearbook last week and we did not want you 
to miss out on all the excitement.” Follow up with 

phone calls or send “last chance” letters to the stu-
dents’ homes.
 As you crop and caption photos, have a stack of 
preprinted notes that say “Hey! You are on page 
____ of this year’s yearbook. Be sure to buy a copy.” 
Hand them out in homerooms to entice students to 
buy. They’ll be more likely to if they know they’re 
in it.

tHINK MCDONALD’S® AND BURGER KING® –
GIVE A PRIzE wItH EACH PURCHASE

 Do you remember when all you wanted was a 
Happy Meal® just because you got the latest movie 
action figure with the hamburger? And once one 
kid in the neighborhood had one, all the kids want-
ed one. You can create the same excitement for 
your yearbook by finding an inexpensive gift to 
give away with every yearbook purchase. Look for 

a popular item you can buy in bulk, inexpensively, 
or one that you may be able to have donated by a 
local business. Bumper stickers, pens, key chains, 
candy, magnets or an instant photo with one of 
your spokespersons are just a few ideas. Be cre-
ative. Gifts can tie in with your theme and generate 
excitement for the arrival of the book as well.
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 So you want to add extras to your yearbook – nat-
ural color photographs, a printed endsheet, a cover 
with special features – and the budget won’t stretch 
that far. Why not let local businesses, parents and 
fellow students fund your frills by starting an adver-
tising section.
 There are two popular ways to present and sell 
advertisements. The first is to sell Space ads, giving 
advertisers a choice of full, half, quarter, or eighth 
page divisions. Calculate ad page prices in relation-
ship to the cost of adding pages to ensure that they 
provide you with a profit. The best idea is to double 
your page rate for a full page ad, then charge slightly 
more than half the cost for the lesser areas because 
that often motivates the advertiser to graduate to the 
next category. For example, if your additional page 
rate is around $75, then charge $150 for a full page 
ad, $85 for a half page, $45 for a quarter page, and 
$25 for an eighth page. You’re most profitable when 
you sell eight business card sized eighth page ads, 
generating $200.
 A second advertising style, and a more space-
saving alternative, is to sell Patron ads. Instead of 
buying a certain portion of the page, the advertiser 
buys lines of type in a certain dollar category. For 
example, designate benefactor, sponsor, donor, 
patron, booster, gold club, silver club, business 
entry, in memoriam,  etc. as various categories. The 
emphasis here is on supporting the school’s publica-
tion, not in advertising products or services. Yet, the 
result is the same: extra dollars for the yearbook. The 
appeal of the patron is in the choice of category and 
the freedom from having to create a visual space ad. 
Likewise, the staff enjoys the convenience of simply 
arranging columns of type that can be interspersed 
with photographs, special features, and graphic 
accents.

 Patrons often range from a high of $100 to a low 
of $5. By simply selling lines of type you can gener-
ate thousands of dollars. For example, you can fit 
about 75 lines of type in a column, and three col-
umns on a page. Selling the patrons at just $5 per 
line, you generate $1,125 in revenue, offset by the 
cost of adding the page, around $75. That’s quite a 
profit.
 Where do you look for the advertisers? Seek out 
suppliers to the school community and businesses 
that service the surrounding area. Your students 
and families patronize these establishments and 
they will be the first ones to consider reciprocation. 
Avoid chain stores and mall stores since they often 
have central advertising departments with national 
campaigns. Look to the parents of students, some of 
whom may own or operate businesses. Parents may 
also consider buying an ad as a vehicle to congrat-
ulate their children. These messages will be more 
valuable than business ads since they have a per-
sonal touch.
 Lastly, look to your students to buy their own ads 
or messages. Homerooms, clubs, teams, and indi-
viduals may purchase space, offering special mes-
sages to each other.
 Follow some basic guidelines when soliciting, 
accepting or portraying ads and patrons. Check 
with the school administration before pursuing any 
advertisers because there may be a policy or practice 
of “hands-off” during other campaigns. Proofread 
entries to avoid inappropriate language, double 
meanings, phrases that readers may misinterpret, or 
illegal reprinting. 
 Remember, selling advertisements and patrons 
can yield big profits, and these extra dollars can go a 
long way in  enhancing your yearbook.

SELLiNg AdS
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We accept four formats for senior page files and  
advertising page files:
1. QuarkXPress® 6.0, 6.5 or 7.0 file
2. Adobe® InDesign® CS2, CS3 or CS4 file

3. Adobe® Photoshop® 6.0, 7.0, CS, CS2 CS3 or CS4 
“JPEG” file

4. PDF file.
Do not provide Microsoft® Word®, Publisher® or 
any other incompatible page design program files.

PROGRAMS tO USE

DIGItAL PHOtOGRAPHY GUIDELINES

• Photographs and/or art must be supplied at the 
size required by the layout.
• Photographs and/or art must be no less than 300 
D.P.I./Resolution at the size it will be on the layout.
• Photographs must be 8 Bits/Channel

• Photographs and/or art must be saved as gray-
scale if they are not printing in color in the year-
book.
• Save photographs and/or art as a “JPEG” file and 
DO NOT COMPRESS OR FLATTEN.

PAGE DESIGN GUIDELINES FOR 9” x 12” BOOKS

Full-bleed senior pages are 9-1/8” x 12-1/4” 
Full-page ads are 8” x 11”
Half-page ads are 8” x 5-1/2”

Quarter-page ads are 4” x 5-1/2”
Eighth-page ads are 4” x 2-3/4”

When students or parents create senior pages and/or ad pages, they must follow certain guidelines. The 
following list of rules will help them complete pages that will be compatible with our page-prep software.

PAGE DESIGN GUIDELINES FOR 8-1/2” x 11” BOOKS

Full-bleed senior pages are 8-5/8” x 11-1/4” 
Full-page ads are 7-1/2” x 10”
Half-page ads are 7-1/2” x 5”

Quarter-page ads are 3-3/4” x 5”
Eighth-page ads are 3-3/4” x 2-1/2”

OtHER GUIDELINES

• If the page is designed with QuarkXPress® or Adobe® 
InDesign® be sure not to use any extensions or plugin 
features in the design. 
• Include both screen and printer parts of Postscript 
font files in Macintosh format or OpenType or 

True Type font files on the disk submitted to Cooke 
Publishing Company.  Refer to the “Usage” option 
from the “Utilities” menu in QuarkXPress® or the 
“Preflight” dialog box from the “File” menu in 
InDesign® to determine which fonts are being used 

prEpAriNg digiTAL SENiOr & Ad pAgES
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in the document. Remember that when an EPS file 
uses a font, that font must be included on the disk. 
The above-mentioned menus will list all fonts used 
including the EPS files.
• Also include on the disk all linked images used 
in the the QuarkXPress® or Adobe® InDesign® files. 
These links will include any clipart, scans, digi-
tal photos, etc. Do not embed links into the page 
design file. 
• If the yearbook is printed in black and white, do 

not design a page with color. If the clipart being 
used has color in the file, remove all color from 
the clipart file first and then place it in the docu-
ment.
• Print a copy of the final page exactly as it is saved 
on the disk.
• Save the finished page on a CD.
• On the CD write the job number of your school, 
the name of the student, and the page on which the 
file belongs.
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Now is the time to be attentive to the accurate 
submission of copy. The following is a partial list of 
some common places where consistency, punctua-
tion and grammar often cause problems. Changing 
your copy on proofs adds time and money – try to 
avoid it.

Group Identifiers
• Captions for group photographs should begin 
with the name of the group only if it doesn’t already 
appear as a headline.
• According to the Columbia Scholastic Press 
Association, rows in group captions should be list-
ed as follows: Two rows should read Front Row, 
Back Row. Three or more rows should read Front 
Row, Second Row, Third Row, Back Row. 
• Use a colon (:) after the row designation, a comma 
between names, and a period after the last name in 
each row. For example: VARSITY SOCCER. Front 
Row: John Smith, Bob Jones, José Garcia. Back 
Row: Ed Poe, Al Einstein, James Joyce. 
•  When keying type, let the computer wrap the 
type. Do not begin each row on a new line by hit-
ting a hard return. 

In Senior Directories
• Use either Street, Road or St., Rd. – not a combi-
nation of both.
• Use well-recognized abbreviations such as NHS 
for National Honor Society or  SADD for Students 
Against Destructive Decisions, but do not use 
unusual ones such as Ftbl. for Football or Bnd. for 
Band.
• It is easy to accommodate offices held after the 
number of years by using parentheses. For exam-
ple: Yearbook 9, 10, 11, 12 (Editor); Baseball 10, 
11 (Captain). Be sure to key one space after com-
mas and before parenthesis. Make sure punctua-
tion is consistent. 

Multiple Spellings
There are many words in the English language 

that have more than one acceptable spelling. For 
example: advisor, adviser. Both of these are cor-
rect, but only one should be used in your book. 
Choose one and stick to it.

SEt UP A StYLE SHEEt FOR CONSIStENCY

wHAt’S IN A NAME

The most grievous error that can be made in a 
yearbook is to misspell a name (especially if it’s 
yours). Carefully check all name spellings against 
official lists. Smart yearbook staffs even check the 
official lists with the students. Readers may over-
look a grammatical goof, but they never forget if 

their names are misspelled.
If your list of senior, faculty, and/or underclass-

man names comes from the school database, make 
sure middle initials and abbreviations are followed 
by a period (ex. Jr., Sr., Rev.).

AvOidiNg MiSTAkES
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• Ask your portrait photographer to provide digital 
portraits on a CD and save them in folders by class 
(seniors, juniors, sophomores, freshmen, faculty).
• Portraits must be saved in “last name, first name” 
format.
• Portraits must be vertical, grayscale, 300 resolu-
tion, non-compressed JPEG files.
• Verify that every senior, underclassmen and/or 
faculty member is on the CD.
• If a portrait is missing on the CD please con-
tact your portrait photographer to obtain the miss-
ing portrait. If a student or faculty member never 
had their portrait taken fill their photo block on 

the layout with gray or remove them from the 
sequence and place their name at the end of the 
section under “Not photographed.”
• Contact the parents of seniors not photographed 
and let them know you do not have a portrait of 
their child for the yearbook. Better to let them 
know early in the year and possibly have one 
taken than get an angry phone call in June.
• Senior sections, faculty sections and underclass 
sections should be complete when handed in. The 
deadline is not complete unless all photographs 
are provided.

prEpAriNg pOrTrAiTS
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Captions are the most widely read words in the 
yearbook, so they must be informative, interesting 
and accurate. They must identify the people in the 
photograph, plus give background information. 
Every photo should have a caption. A photo with-
out a caption is like TV without sound.

The sentence that describes the photo’s action 
(usually the first sentence) is written in present tense. 
For example: With a little soap and water and a lot 
of elbow grease, Megan Smith adds the finishing 
touch to a fender during the September 27 Senior 
Car Wash. Sentences that provide background infor-
mation are written in past tense. The car wash raised 
$160 to add to the senior class gift.

Tips for good captions
• Write the caption to tell a complete story. Think 
of the caption as a photo essay, not just a descrip-
tion of the photo.
• Use an interesting lead to attract the reader to 
the caption. Begin with a quote, adjective, mini-
headline, or prepositional phrase for variety. 
• Answer the reader’s questions: who, what, when, 
where, why, and how. Vary the order in which you 
answer these questions. Megan Smith shines a car 
fender during…, At the September 27 Senior Car 
Wash, Megan Smith shines…, To raise money for 
the senior class, Megan Smith shines… 
• You can include information in the caption about 
what occurred just before or just after the photo 
was snapped. Tell the reader more than he can see 

with his own eyes. Use quotes from the students 
involved to add depth to the caption. 
• Be accurate. Check identifications, name spell-
ings and details. Remember that you are preparing 
not only a memory book, but a historical record. 
• If you cropped someone out of a photo, carefully 
check to see that his/her name does not appear in 
the caption, and vice versa. 
• Require staff photographers to turn in complete 
identifications and descriptions with their photos, 
or send a reporter on location with the photogra-
pher to take notes. Ask the people in the photo-
graph to shed some light on the particular moment 
in time.
• Captions for group photographs should begin 
with the name of the group if it doesn’t already 
appear on the page as a headline. According to 
Columbia Scholastic Press Association, rows 
should be listed as follows: Two rows should read 
Front Row, Back Row. Three or more rows should 
read Front Row, Second Row, Third Row, Back 
Row. Keep this style and punctuation consistent 
for the entire book.
• Avoid phrases such as: is shown, pictured left 
or above, poses for the camera, from left to right, 
seems/appears to, attempts/tries to. Do not state the 
obvious (Sue smiles for the camera), or use “gag” 
captions (Got a flat, Henry?), because they do not 
add any relevant information to the photo. Also, 
avoid the photo “talking” to the reader or the read-
er “talking” to the photo. (Hey, Jane, nice hat!)

CAPtIONS

COPY FOR FEAtURE StORIES

Essays provide the details and the background 
information that photos can’t give. Write your 
stories in the past tense (by the time the book is 

published, all the events already will have taken 
place). Use interesting leads and a strong closing. 
Use third person and active voice.

wriTiNg COpy
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• Headlines relate all the elements on the page. 
They should work as a unit with the copy and be 
positioned to “touch” the copy.
• Write headlines in the present tense, active 
voice.
• Tie the headline in with the action of the domi-
nant photo.
• To write a good headline: read the copy, jot 
down key thoughts and words, then think of a 

catch-phrase that includes one of the key words 
or phrases. 
• Use clever play on words to intrigue the reader.
• Eliminate unnecessary words.
• Don’t use label or cliché heads. (“Field Hockey” 
or “Get a kick out of Soccer”)
• Create a clip file of interesting headline styles for 
future reference.

HEADLINES

Tips for good copy
• Avoid “cookie-cutter” copy that could be used 
for any year and any school, such as; This year, 
the football team practiced hard and played well. 
Every person gave 110%. Use specifics such as 
game/event descriptions, statistics and quotes to 
make the story come alive.
• Brainstorm for interesting angles to annual 
events. Look at a dance from the decorating com-
mittee’s view. Talk to the athlete who sat on the 
bench most of the season. Focus on dress rehearsal 
for the school play.
• Use direct quotes. They will give an insider’s 
view, plus the students will love to see their words 
in print. Interview a variety of students and faculty.
• Use various leads. Try:

The Astonisher Lead: You may be dead tomor-
row. That is the consensus of the American Lung 
Association who yesterday launched a new pub-
lic awareness campaign to stop smoking.

The Descriptive Lead: He walked slowly down 
the aisle eyeing up his victims. Tension mounted 
and eyes averted – no one wanted to be the one. 
Mr. Crowley’s hand came down on Sue Smith’s 
shoulder. “You give the first speech.”
Question Lead: “Are you feeling incurably lazy? 
Constantly fatigued? Plagued by chronic apa-
thy? All of the above? You might be a victim of 
senioritis.
Contrast Lead: Despite the fact that cartoons, 
movies and comics portray the beginning of 
school as the return to a type of prison life, there 
is ample proof that many students return to their 
books with a thankful “it’s great to be back.”
• Words and phrases to avoid in copy: The year, 
school name, team name, the purpose of, the 
goals of, during this year, we hope to do better 
next year.

Use a survey:
• To gather background information.
• To get lively quotes.
• For “Top 10” lists (favorite TV show, movie, 
food).
• To elicit ideas for feature stories, personality pro-
files, “remember whens.”

• To compile a “Q and A” list.

Survey Suggestions
• Write specific open-ended questions. Ask Which 
school dance was your favorite and why? instead of 
Did you attend school dances?
• Keep it short and simple.

SURVEYS
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• Personally collect the responses or have them 
returned to a specific place on a specific date.
• Have students fill out surveys and return them 
during homeroom and you will be certain to get 
the information you need without hunting for 
responses.

Sample Survey Questions
Seniors
Name, nickname, address, activities, favorite 
quote.
What are your post-graduation plans? What part-
time jobs have you held in high school? Describe 
a college you’ve visited. What teacher will you 
remember most and why? What is your favorite 
hobby/after-school activity?

Faculty
Name, degree, classes taught, activities moderated 
(for faculty bio).
Where did you travel/what did you do this sum-
mer? What are your out-of-school activities? What 
adjectives would you use to describe this senior 
class? What was your most embarrassing moment 
as a teacher? Why did you choose to moderate 
____________?

Clubs
Club name, purpose, officers, adviser, members.
What fundraisers are you planning? Who is the 
most active member in your club and why? How 
much money do you hope to raise and for what 
purpose? Describe a typical meeting. How is club 
participation different from last year?

Sports
Name, grade, sport, position.
What was the most memorable game/match this 
season and why? In what area do you think the 
team improved the most as the season progressed? 
What is the best part of practice? The hardest 
part? What has your team done to unify its mem-
bers (such as dinners, breakfasts, pep talks, songs, 
nicknames, etc.)? What is the funniest or weird-
est thing that ever happened during a game/match 
this year?

• Remember: Surveys are useful tools for infor-
mation gathering, but a story should not be based 
solely on survey information; to truly capture the 
year as it was, the writer needs to attend a club 
meeting or sporting event, meet with a personality, 
etc., to add depth to the description.

Yearbook stories come alive with quotes from 
students, teachers, coaches – real, live people! 
Quotes from people who have first-hand knowl-
edge of the event add realism and spice to your 
prose, plus generate enthusiasm in your yearbook 
audience since people love to see their names in 
print. The secret to obtaining a good quote is…

The Interview
• Identify sources, those with first-hand knowledge 
of the event or subject.
• Set up appointments to interview sources. Your 

sources may be as busy as you are, so it’s not fair to 
force a quote from them as they leave the building. 
Schedule a mutually convenient time and be punc-
tual. Find a place to chat that is fairly quiet and free 
from interruption.
• Gather background information. Before you 
can ask an intelligent question, you have to know 
something about the subject. If you’re interview-
ing a basketball player, attend a game or talk to 
fans about the player’s record. Read past yearbook 
stories to see what’s been said about your sub-
ject. Other good sources for background info are: 

INtERVIEwS
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school announcements, the guidance office, the 
master schedule, school calendar, student hand-
book, school and community newspapers.
• Plan your questions. Write open-ended ques-
tions that elicit answers beyond yes or no. Instead 
of asking, Did you enjoy the Soph Hop? ask, What 
were your impressions of the Soph Hop? Plan 5 to 
10 questions per interview focused on the source’s 
area of expertise. Ask the Activities Director about 
planning the event; ask the student about attending 
the event.
• Listen to your subject. After you ask a question, 
listen to the response, then follow-up on interest-
ing comments before plunging into the next ques-
tion. Be as conversational as possible – this allows 
the source to relax and to give more spontaneous 

quotes. Some students use a tape or USB record-
er to avoid slowing up the interview, but be sure 
to get permission from the source and to still take 
notes – it will help you to remember the key points. 
Besides responses, write down a description of the 
person and the scene to add color to your story.

Additional Tips
• Interview multiple sources for the same story.
• Try conducting an interview with a group of stu-
dents at a lunch table or an activity meeting. This 
will generate many quotes at one meeting.
• A good quote adds information to the story and 
doesn’t state the obvious.
• Place in quotation marks only the exact words of 
the source. Never fabricate quotes.



We take everything personally

607 louis drive • warminster, pa • 18974 • phone: 215.957.2701 • fax: 215.957.2705

www.cookebooks.com

COOKE
PUBLISHING 
COMPANY

PAGE 18

We are pleased to provide you with your Yearbook 
Dummy. “Dummy” layouts are full-sized renditions 
of your pages prepared by the designers at Cooke 
Publishing Company. We follow your pagination 
guide and your theme explanation to produce spe-
cial layouts for your opening pages and dividers, and 
style layouts to establish margins, type fonts, rules, 
panels, and guidelines for the individual sections of 
your yearbook. 

0 Determine How Much Copy to Write... Look at 
each layout to see where the story will go. Then, using 
the Cooke Copy Fitting Chart (that’s the clear plastic 
sheet with columns and numbers on it), determine 
the maximum number of words that will fit the copy 
area in 10 point size, that’s the most popular point 
size for essays. Write the word count on the layout 
and provide the count to the writing staff. Instruct the 
writing staff not to exceed the word count.

0 Mix It Up... Look closely at the different layouts 
for each section (Sports, Activities, Portraits, etc.); we 
usually provide more than one layout. Decide which 
master layout you are using for each layout on our 
pagination plan. Write the master layout letter on the 
pagination. (A, B, C, A, B, C, etc.) over and over until 
you have enough pages for the section. (You will 
need to open the dummy layouts on the computer to 
determine the letter assigned to each layout.) 

0 Make a Note of Caption Length... Just as you did 
with your story boxes, look at the size of your caption 
boxes, the size and style may vary from section to 
section. Determine how many lines and words can 
fit in the space by using your last year’s book as a 
guide for how many lines can fit in a 2-pica deep 
caption, a 3-pica deep caption, and so forth. Write 
your captions according to how many lines fit that 
area. Most captions are 8 point size, so you cannot 
use the Copy Fitting Chart. If your caption is too long, 
you will have to edit it. If you caption is too short, the 
extra white space may seem awkward. So before you 
write and type your captions, think about the impact 
to the layout.

0 When Writing Headlines...  Read the sample 
headlines in each section, most have a special style 
for label and phrase (kicker) headlines. Styles include 
using words over and over, using action verbs to 
begin the headline, or using descriptive adjectives to 
describe the content. Try to write headlines that are 
similar, or, initiate a style of your own for each sec-
tion. Whatever you do, be consistent on every lay-
out within a section. If one headline has five words, 
try to continue that length on the rest for your head-
lines. Keep subheads and kickers, and any other spe-
cial copy on a page, like sidebar stories, pulled-out 
quotes, interviews, polls, and surveys, consistent in 
style and length.

whAT TO dO with ThE dUMMy
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• It is easier to proofread type in Microsoft® Word®. 
(Let those red and green squiggles do some of the 
work for you.) Staff members should key all copy 
and captions in Microsoft® Word®  and save to a 
folder called “Copy In.”
• Identify captions with a page and position num-
ber, which should be keyed on a line by itself. Insert 
a blank line before and after the numbers. 
• If the page numbers show up automatically as you 
are keying, you did not shut off auto-formatting. 
• Turn off auto-formatting in Microsoft® Word®. 
This must be done every time you open a new file. 
(Under the Format menu, go to “AutoFormat...” 
and click on the “Options” button. In the dialog 
box that appears, go to the “AutoFormat As You 
Type” tab and deselect the boxes for “Automatic 
Bulleted Lists” and “Automatic Numbered Lists.” 
On the “AutoFormat” tab, deselect the boxes for 
“Automatic Bulleted Lists” and “Lists.”)
• Key only one space after all punctuation. 
• Let the computer make all of the returns until you 

get to the end of the paragraph, then enter one hard 
return. Do not leave a blank line between para-
graphs. 
• Do not insert page breaks or paragraph breaks.
• Key one tab at the beginning of every paragraph 
to be indented.
• Poetry should be keyed line for line as you want 
it to appear, with hard returns at the end of each 
line to break to the next line.
• Use the “Word Count” feature, under the “Tools” 
menu to check the length of all copy. This count 
should match with the number determined by 
using the Cooke Publishing Company Copy Fitting 
overlay with the layout.
• Advisers should read copy saved in the “Copy In” 
folder, make changes and move the file to a folder 
called “Copy Approved.”
• Once copy and captions are in the “Copy 
Approved” folder, staff members can place the type 
into the Adobe® InDesign® or QuarkXPress® files.

kEyiNg COpy & CApTiONS iN wOrd
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These guidelines have been developed to assist you 
when submitting your complete yearbook pages 
on disk using QuarkXPress®.

You should have a basic knowledge of your com-
puter and the QuarkXPress® 6.0, 6.5 or 7.0 software 
in order to understand the following information.

 If you request a dummy design from our art depart-
ment you will receive a large binder with page lay-
outs (theme pages, dividers and sample pages for 
each section in your book) and a corresponding CD. 
The CD contains your dummy designs saved as tem-
plates – one for each section of your yearbook. Copy 
the Cooke dummy design templates into your year-
book folder on your hard drive. 
 Open a template. Notice that the file opens as 
an untitled document containing two blank pages 
and different master page design options (located 
in the top portion of the “Page Layout” palette)  that 
correspond to your dummy. Assign the proper page 
numbers to your template. Go to “Section…” under 
the “Page” menu and key the left hand page num-

ber of the file you are setting up next to “Number” 
in the dialog box. (e.g. If you are setting up a file 
for pages 44 through 51, key number “44” next to 
“Number.”)  Add the proper number of pages to 
your file by dragging one of the master page icons 
from the top portion of your “Page Layout” palette 
to the bottom portion of the palette. Do not exceed 
10 pages in a file.
 Save the file according to the page numbers it 
contains. If you set up a file for pages 44-51 and 
your school’s job number is 123, the file would be 
called 044-051(123).
 Change headlines and folios when necessary by 
highlighting the dummy type one style at a time 
and keying over the existing words.

wORKING wItH COOKE DUMMY PAGES

 Key copy (essays, captions, etc.) in Microsoft® 
Word®, spellcheck, proofread and save to the hard 
drive or a disk. 
 To import copy, click within your text box with 
your “Content Tool” and go to “Get Text…” under 
the “File” menu. Choose the appropriate file and 
click “Open.” “Select all” of the type, hold down the 
“Option (Mac) or Alt (Windows) key,” and choose 
the appropriate style from the “Style Sheets” palette.
 To link copy from one column to the next, use the 
“Linking” tool to click from one column to the next.
 To import captions, draw a text box on the paste-
board of your Quark file with the “Rectangle Text 
Box” tool and import captions into the text box. 
“Select all” of the type, hold down the “Option (Mac) 

or Alt (Windows) key,” and choose the appropriate 
style from the “Style Sheets” palette. Cut each caption 
individually and paste into the appropriate text boxes 
on the layout. 
 Once the copy and captions are placed, change 
the frames to 0 points.
 If the caption is below a photo, choose “Top” under 
“Vertical alignment” in the “Modify” dialog box. If the 
caption is above the photo choose “Bottom” under 
“Vertical alignment” in the “Modify” dialog box.
 Key or paste names next to portraits and choose 
“Center” under “Vertical alignment” in the “Modify” 
dialog box.
 Check the consistency of type styles (captions, 
copy, and headlines).

PLACING tHE tYPE

USiNg qUArkxprESS ®
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 Do not hyphenate headlines.
 Make sure all columns of type line up horizontally.
 Type that prints in gray should be no less than  
40% black.

 When aligning type, draw the text box to the 
full width of the column and use the justify, cen-
ter, left or right commands in the “Measurements” 
palette.

 Follow the instructions in the USING  
PHOTOSHOP® section of the manual to prepare 
digital photos for placement in QuarkXPress®.
 Change the frame of the picture box to 0 points 
before you place a photo.

 Click on the photo box with your “Content” tool 
and go to “Get Photo…” under the “File” menu. 
Choose the appropriate file and click “Open.”
 Delete the information box containing the photo 
position and dimensions.

PLACING DIGItAL PHOtOS

Setting Up Your Files
 Copy the Cooke layout template into the year-
book folder on your hard drive and open it. Note 
that our template is set up just like our printed layout 
sheets, including margins and columns, but does 
not show the bleed edges. Do not move the zero 
point. Use guidelines and the “Measurements” pal-
ette to measure and place picture and text boxes.
 Set up files containing consecutive pages accord-
ing to your pagination plan and deadline schedule. 
Do not exceed 10 pages in a file. Go to “Section…” 
under the “Page” menu. Check off “Section Start” 
in the dialog box and then key the left hand page 
number of the file you are setting up next to 
“Number.” (e.g. If you are setting up a file for pages 
four through nine, key “4” next to “Number.”) Add 
the proper number of pages to your file by dragging 
the master page icon from the top portion of your 
“Page Layout” palette to the bottom portion of the 
palette.
 Save the file according to the page numbers it 
contains. If you set up a file for pages four through 
nine and your school’s job number is 123, the file 
would be called 004-009(123).
 On the first and last pages of the book, the three 
picas closest to the gutter should not have any type, 
rules, screens or photos. This area is for endsheet 
gluing.

Personalizing Your Files
 Use the automatic page numbering command 
(command +3) when placing the folios on the mas-
ter page. Folios should be 1.5 picas from bottom 
and side trim edges in the lower outside corners. 
 When providing special folios on each page, 
place the page number and dingbat on the master 
page and the name of the event or subject on each 
individual page of your document. 
 Add your second color to the “Color” palette 
according to the Pantone Matching System (PMS) 
number. You can obtain your PMS number from 
your representative.
 Add typography styles for your copy, captions, 
folios, scores, directory information, and name 
lists, etc. to the “Style Sheets” palette. This will 
ensure type style (size, leading, font, weight and 
justification) consistency throughout the book.

Photo Blocks
 Use the “Picture Box” tool to draw all picture 
boxes. Always place boxes on whole numbers. 
Use the “Measurements” palette for accurate place-
ment. 
 Picture boxes should have a 1 point black frame 
around them and the background color should be 
“None.” (The frame will be deleted when the photo 
is placed.) If you would like the frame to print around 

DESIGNING YOUR OwN PAGES 
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 Double check that the file name matches the 
pages listed in the “Page Layout” palette. If they do 
not match, the file name must be fixed.
 Double check all type for style sheet use and 
consistency.
 Double check that headlines and folios are 
accurate.
 Spellcheck, proofread and spellcheck – again.
 Double check your pages against your pagina-
tion for second color availability. Remove any PMS 
color being used on a black and white page.
 Use the F7 key to preview the page. All unfilled 
picture boxes should appear with 1 point black 
frames. 
 Fonts used in your documents must be Postscript 
or OpenType fonts, and be limited to those that 
Cooke Publishing Company lists on the type charts. 
Ask your representative if you are unsure of the 
fonts you are using.
 Include a copy of any EPS or TIFF files placed in 

the document on your disk. 
 If you are supplying and placing clipart for any 
pages, check to see if it is prepared in a color other 
than black. If so, then remove all color from the  
clipart file first and then place in the document. 
(You may need to do this in Adobe® Illustrator® or 
Adobe® Photoshop®.)
 Print out a copy of every page being submitted 
on disk. You may print at a reduced percent so that 
a spread fits on 8-1/2” x 11” paper.
 Check your printouts. If you find an error on your 
printout, fix the error, save the file and reprint the 
page.
 Save your files on a CD or zip disk. Save only 
the pages you are submitting for the deadline and 
remember to include ALL links. 
 Label your CD or DVD with your school name, 
job #, deadline number, and content.
 Remember to keep a copy of the disk and print-
outs for yourself.

PREPARING tHE PAGES FOR DEADLINE SUBMISSION

your picture, please indicate that on the print out.
 Key the picture box position number and pica 
dimensions (width x height) in a text box placed on 
top of the corresponding picture box.

Portrait Blocks
 All picture boxes should be drawn individually 
butted against each other. Apply a 1.5 point black 
frame to each picture box. If a student does not 
have a portrait, change the background color of 
the box to 30% black.
 Key the picture box position number and the 
portrait pica dimensions in a text box placed on 
top of the corresponding picture box. 

Screens & Rules
 Normal gray screens should be 20%. To make 

a gray screen draw a box with the “Picture Box” 
or “Text Box” tool, choose black from the “Color 
palette” and then select 20% under the tint menu. 
Do not choose a PMS gray.
 Be consistent with line weights within a  
section.
 Place lines and screens in appropriate PMS color 
if second color is being used on layout.

Text Blocks
 Use the “Text Box” tool to draw all text boxes. 
Always place boxes on whole numbers. Use the 
“Measurements” palette for accurate placement. 
 Text boxes should have 0.5 point black frame 
around them and the background color should be 
“None.”
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These guidelines have been developed to assist you 
when submitting your complete yearbook pages 
on disk using Adobe® InDesign®.

You should have a basic knowledge of your com-
puter and the InDesign® CS2, CS3 or CS4 software 
in order to understand the following information.

 If you request a dummy design from our art 
department you will receive a large binder with 
page layouts (theme pages, dividers and sample 
pages for each section in your book) and a cor-
responding CD. The CD contains your dummy 
designs saved as templates – one for each section 
of your yearbook. Copy the Cooke dummy design 
templates into your yearbook folder on your hard 
drive.
 Open a template. Notice that the file opens as 
an untitled document containing two blank pages 
and different master page design options (located 
in the top portion of the “Pages” palette) that cor-
respond to your dummy. Assign the proper pages 
numbers to your template. Go to “Numbering & 
Section Options…” in the “Page Layout” palette 
menu. Select “Start Page Numbering at” and key 
in the left hand page number of the file you are 

setting up (e.g. If you are setting up a file for pages 
44 through 51, key number 44). Add the proper 
number of pages to your file by dragging the cho-
sen master page icon from the top portion of your 
“Pages” palette to the bottom portion of the palette. 
Do not exceed 10 pages in a file.
 Save the file according to the page numbers it 
contains. If you set up a file for pages 44-51 and 
your school’s job number is 123, the file would be 
called 044-051(123).
 To “unlock” the pages, select all of the pages in 
the “Pages” palette by clicking the page icons while 
holding the shift key. Go to “Override All Master 
Page Items” in the “Pages” palette menu.
 Change headlines and folios when necessary by 
highlighting the dummy type one style at a time 
and keying over the existing words.

wORKING wItH COOKE DUMMY PAGES

 Key copy (essays, captions, etc.) in Microsoft® 
Word®, spellcheck, proofread and save to the hard 
drive or a disk. 
 To import copy, click within the text frame with 
the “Text” tool and go to “Place” under the “File” 
menu. Choose the appropriate file and click “Open.” 
“Select All” of the type, hold down the “Option (Mac) 
or Alt (Windows) key,” and choose the appropriate 
style from the “Paragraph Styles” palette.
 To link copy from one column to the next, click 
on the red box located at the lower right corner of 
the first column with the “Selection” tool and then 

click in the second column.
 To import captions, draw a text frame on the paste-
board of your InDesign® file with the “Rectangle 
Frame” tool and import captions into that text frame. 
“Select All” of the type, hold down the “Option (Mac) 
or Alt (Windows) Key,” and choose the appropriate 
style from the “Style” palette. Cut each caption indi-
vidually and paste into the appropriate text frames 
on the layout. 
 Once the copy and captions are placed, change 
the text frame strokes to 0pt.
 If the caption is below a photo, choose “Text 

PLACING tHE tYPE

USiNg AdOBE® iNdESigN ®
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Frame Options” from the “Object” menu and set 
the “Vertical Justification” to Top. If the caption is 
above a photo, choose “Text Frame Options” from 
the “Object” menu and set the “Vertical Justification” 
to Bottom.
 Key or paste names next to portraits and choose 
“Center” as the “Vertical Justification” in the “Text 
Frame Options.”
 Check the consistency of type styles (captions, 

copy, and headlines).
 Do not hyphenate headlines.
 Make sure all columns of type line up horizon-
tally.
 Type that prints in gray should be no less than 
40% black.
 When aligning type, draw the text frame to the 
full width of the column and use the justify, center, 
left or right commands in the “Control” palette.

 Fol low the instruct ions in the USING 
PHOTOSHOP® section of the manual to prepare 
digital photos for placement in InDesign®.
 Change the stroke of the photo box to 0pt. before 
you place a photo.

 Click on the photo box with your “Selection” tool 
and go to “Place” under the “File” menu. Choose 
the appropriate file and click “Open.”
 Delete the information box containing the photo 
position and dimensions.

PLACING DIGItAL PHOtOS

Setting Up Your Files
 Copy the Cooke layout template into the year-
book folder on your hard drive and open it. Note 
that our template is set up just like our printed lay-
out sheets, including margins and columns, but 
does not show the bleed edges. Do not move the 
zero point. Use guides and the “Control” palette to 
measure and place photo and type frames.
 Set up files containing consecutive pages accord-
ing to your pagination plan and deadline schedule. 
Do not exceed 10 pages in a file. Go to “Numbering 
& Section Options…” from the “Pages” palette 
menu. Select “Start Page Numbering at” and key 
in the left hand page number of the file you are 
setting up (e.g. If you are setting up a file for pages 
four through nine, key a number 4). Add the proper 
number of pages to your file by dragging the mas-
ter page icon from the top portion of your “Pages” 
palette to the bottom portion of the palette.
 Save the file according to the page numbers it 
contains. If you set up a file for pages four through 
nine and your school’s job number is 123, the file 
would be called 004-009(123).
 On the first and last pages of the book, the three 

picas closest to the gutter should not have any type, 
rules, screens or photos. This area is for endsheet 
gluing.

Personalizing Your Files
 Use “Auto Page Number” from the “Insert 
Special Character” sub menu of the “Type” menu 
when placing the folios on the master page. Folios 
should be 1.5 picas from bottom and side trim 
edges in the lower outside corners.
 When providing special folios on each page, 
place the page number and dingbat on the master 
page and the name of the event or subject on each 
individual page of your document.
 Add your second color to the “Color” palette 
according to the Pantone Matching System (PMS) 
number. You can obtain your PMS number from 
your representative.
 Add typography styles for your copy, captions, 
folios, scores, directory information, and name 
lists, etc. to the “Paragraph Styles” palette. This will 
ensure type style (size, leading, font, weight and 
justification) consistency throughout the book.

DESIGNING YOUR OwN PAGES 
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Photo Blocks
 Use the “Rectangle Frame” tool to draw frames 
for photos. Always place frames on whole numbers. 
Use the “Control” palette for accurate placement.
 Photo frames should have a 1 point black stroke 
and a fill of None. (The stroke will be deleted when 
the photo is placed.) If you would like the frame to 
print around your photo, please indicate that on the 
layout.
 If Cooke is scanning and placing your photos, key 
the photo position number and pica dimensions 
(width x height) in a text frame placed on top of the 
corresponding photo frame.

Portrait Blocks
 All photo frames should be drawn individually, 
butted against each other. Apply a 1.5 point white 
stroke on each portrait frame. If a student does not 
have a portrait, fill the frame with 30% black.
 If submitting portrait prints for mounting, do not 
draw the photo frames individually on the layout. 
The portraits for each page are scanned as a group. 
Therefore you should draw one photo frame that 
is big enough for all the portraits on that page. Use 
3 point horizontal and vertical black lines to the 
separate the portraits. These lines will be changed 

to white when the portraits are placed. If a student 
does not have a portrait or has a candid photo to 
be used as a portrait, draw that frame individually 
and place it over the larger photo frame. Fill the 
frame with 30% black.
 If Cooke is placing your portraits, key the photo 
position number and the portrait pica dimensions 
in a text frame placed on top of the corresponding 
photo frame. 

Screens & Lines
 Normal gray screens should be 20%. To make a 
gray screen, draw a box using either the “Rectangle 
Frame” or “Type” tool, choose black from the 
“Swatch” palette and then select 20% under the 
tint menu. Do not choose a PMS gray.
 Be consistent with stroke weights within a section.
 Place lines and screens in appropriate PMS color 
if second color is being used on layout.

Text Blocks
 Use the “Type” tool to draw frames for text. 
Always place frames on whole numbers. Use the 
“Control” palette for accurate placement.
 Text frames should have 0.5 point black stroke 
and a fill of “None.”

InDesign® has the ability to create an index. It can 
build the index across multiple documents, will 
automatically reverse proper names and can be 
worked on as the year progresses.
• In each file:
– Make sure the pages in each file are numbered 
correctly by using the Numbering & Section 
Options in the Page Palette.
– Have some file storage system. You need to 
know where every file in the book is located.
– The files should be named correctly, showing 
the pages the file contains. For example: 024-
031(0825).
• As a file is completed, proofed and the deadline 

has passed, you can begin to mark the items you 
want to appear in the index.
–  O p e n  t h e  I n d e x  p a l e t t e  f r o m 
Window>Type&Tables>Index.
– In the document window, highlight the word(s) 
you want to index.
– Portrait names or group captions can be indexed 
several names at a time if each name to be indexed 
is separated with a return, a soft return, a tab, a 
semicolon, or a comma.
– For compound last names or names with a 
title, include one or more nonbreaking spaces 
or hyphens between the words. For example, if 
you want to index “James Carter Jr.” by “Carter” 

INDExING
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instead of “Jr.”, place a nonbreaking space 
between “Carter” and “Jr.” (Type>Insert White 
Space>Nonbreaking Space or Type>Insert Special 
Character> Nonbreaking Hyphen.)
• “Mark” the highlighted word(s)
– For standard words or phrases, press
 Shift+Option+Command+[ (Mac OS) 
 Shift+Alt+Ctrl+[ (Windows)
– For proper names that you want indexed by the 
last name, press
 Shift+Option+Command+] (Mac OS)
 Shift+Alt+Ctrl+] (Windows)
– An invisible index marker is added at the begin-
ning of the selection. You can view the marker 
by turning on invisibles (Type>Show Hidden 
Characters). You will also see the names or words 
appear in alpha order in the Index palette
• SAVE and close. Move on to the next file. 
Repeat. Make sure to mark all names and topics 
in all files.
• After all pages are marked, you can begin to 
build the index. File>New>Book will allow you 
to tie all of the files together. Name the book Index 
and save it with your deadline files.

 A Book Palette will appear. Use the + sign on 
the bottom of the palette to add all of your year-
book files to the book. Be sure to get every file. 
When you look at the book list, the files should 
read from 1 to which ever is the final page num-
ber of the book.
• Open the InDesign® file that contains the pages 
for the Index. From the Index palette pop menu, 
select Generate Index.
– Use Index for the title
– Check Include Book Documents
– Hit OK
– Depending on the size of the index, generating 
make take a few minutes, or possibly many min-
utes. Be patient.
• The cursor will change to a loaded text icon. 
Start placing the index text in the upper-left cor-
ner of the first page.
• The index entries and section headings will 
appear in a default style. Change the style by 
choosing “Select All”, hold down the “Option 
(Mac) or Alt (Windows) key,” and choose the index 
style from the “Paragraph Styles” palette.

 Double check that the file name matches the 
pages listed in the “Pages” palette. If they do not 
match, the file name must be fixed.
 Double check all type for style use and consistency.
 Double check that headlines and folios are 
accurate.
 Spellcheck, proofread and spellcheck – again.
 Double check your pages against your pagina-
tion for second color availability. Remove any PMS 
color being used on a black and white page.
 Use “Show Guides” and “Show Frame Edges” 
to preview the page. All unfilled photo frames 
should appear with a 1 point stroke.
 Fonts used in your documents must be Postscript, 
OpenType or TrueType fonts, and be limited to 
those that Cooke Publishing Company lists in the 

Typefaces and Fonts Book. Ask your representa-
tive if you are unsure of the fonts you are using.
 If you are supplying and placing clipart for any 
pages, check to see if it is prepared in a color other 
than black. If so, then remove all color from the 
clipart file first and then place in the document. 
(You may need to do this in Adobe® Illustrator® or 
Adobe® Photoshop®.)
 Print out a copy of every page being submitted 
on disk. You may print at a reduced percentage so 
that a spread fits on 8-1/2” x 11” paper.
 Check your printouts. If you find an error on 
your printout, fix the error, save the file and reprint 
the page.
 When your files are ready for deadline submis-
sion, select “Preflight...” from the “File” menu. (You 

PREPARING tHE PAGES FOR DEADLINE SUBMISSION
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will need to open one file at a time to do this.) A 
summary window will appear that will alert you to 
any problems. If a yellow triangle with an exclama-
tion point appears next to the links summary, click 
the word “Links and Images” in the list to the left. 
A list of all links used in your file will appear and it 
will list them as Linked or Missing. You must locate 
all missing links (with the exception of Cooke art) 
before you can proceed.
 Once all links are located and there are no 
yellow triangles with exclamation points in the 
summary window, click “Package.” A “Printing 

Instruction” window will appear. Key the name 
of your school where it says company and click 
“Continue.” Choose the folder called “Packaged 
Files” in the appropriate deadline folder, to save 
all of your collected deadline material in and 
click “Save.” 
 Repeat the “Preflight…” and “Package” steps 
for all files in the deadline. 
 Burn the Packaged folders on a CD or DVD. 
 Label your CD or DVD with your school name, 
job #, deadline number, and content.
 Remember to keep a copy of the disk and print-
outs for yourself.
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1. Open Adobe® Photoshop®.

2. On the menu bar go to “Photoshop” and select 
“Preferences”, then “General”, and then “Units 
and Rules.” Choose “Picas” next to ruler, then hit 
“OK.”

3. If the “Tools” and “Options” palettes are not 
open, you will need to open them. Go to “Window” 
on the menu bar and select “Tools” and “Options.” 
Place these two windows off to the right side of your 
screen out of the way. Close any other windows that 
are open because you will not need them. They only 
clutter your desktop. 

4. Go to “File” on the menu bar and select “Open”, 
locating the digital photo you want to work on. (If 
a dialog box comes up, select “Don’t Convert.”)

5. If the photo appears on its side, go to “Image” on 
the menu bar and click on “Rotate Canvas.” Select 
the appropriate direction to rotate.

6. Go to “Image” again and click on “Mode.” If 
the photo will appear in the yearbook in color, it 
should be set on “CMYK Color.” If it will appear in 
black and white, it should be set on “Grayscale.” 
(If you need to convert a color photo to grayscale, 
select “Grayscale” from the “Mode” menu and hit 
“Yes” when asked to discard color information.)

7. Prepare to crop the photo.
(a) From the page layout, determine the size that 
the photo will appear in the yearbook.
(b) Click on the “Cropping” tool on the tool 
bar. This will activate the cropping  tab in the 
“Options” window.
(c) On the cropping tab in the “Options” win-
dow, enter the following information:

(1) Enter the width measurement plus 1/2 pica  
into the “Width” box.
(2) Enter the height measurement plus 1/2 pica 
into the “Height” box.
(3) Enter 300 into the “Resolution” box.

8. Place the cropping tool at the top left-hand cor-
ner of the photo, then click and drag it across the 
photo. This will create a rectangle that will be 
proportional to the sizes you set in the “Options” 
window. By selecting the little squares on the cor-
ners of the crop lines, you can alter the size of 
the rectangle but not its proportions. By clicking 
inside the rectangle and holding while dragging 
the mouse, you can move the rectangle around 
the photo. By clicking outside the rectangle and 
dragging your mouse, the rectangle can be rotated 
to straighten the photo. When you have the rect-
angle placed perfectly over the part of the image 
you want to use, double click inside the rectan-
gle or hit “Enter.” The photo will be cropped and 
sized 1/2 pica larger than the photo block on the 
layout.

9. Save the photo. 
(a) Go to “File” on the menu bar and select 
“Save As.”
(b) Save in this format: “000_00” (“000” is the 
page number, and “00” is the position num-
ber).
(c) Locate the images folder within the appropri-
ate deadline folder.
(d) Select “JPEG” as the format, and then 
“Save.”
(e) Another dialog box will appear. Key “11” next 
to “Quality” under “Image Options” and click 
“Baseline Standard” under “Format Options.”

10. Repeat steps 4 through 9 for every photo.

USiNg AdOBE®  phOTOShOp ®
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Note: All of the photos that you wish to batch must 
be in one folder and you will create a new folder 
on your desktop for your converted photos.

1. Using one photo from your folder, you are 
about to program your application to perform an 
Action that you can repeat over and over. Open 
Photoshop®. 

2. On the menu bar go to “Window” and select 
“Actions.”

3. On the menu bar go to “File” and select “Open” 
and open just one of the photos you want to 
batch.

4. On the “Actions Palette”, top right hand side 
is a small arrowhead pointing to the right.  Click 
on this and select “New Action… .”  Name your 
action “Color to Grayscale” and click   “Record.” 

5.  Look at the bottom of the “Action” palette. The 
“Record” button should be red confirming that 
recording is in progress.  

6. With the photo open, go to the menu bar 
under “Image” and select “Mode” and then select 
“Grayscale.” When asked, “Discard color infor-
mation?” select “OK” and a grayscale version of 
your photo will replace the original.

7. On the menu bar go to “File” and select “Save 
as… .” The original name of the photo should 
appear, don’t change it, yet select the format 
“JPEG.” At this point you can make a new folder on 
your desktop in which to save the photo(s). Click 
“Save.” When the next window pops up key “11” 
next to “Quality” under “Image Options” and click 
“Baseline Standard” under “Format Options.”
 Click “OK.”

8. Close the photo.

9. Return to the “Actions Palette.” Look at the bot-
tom left corner next to the red record button and 
you will see a square box. That is the stop record-
ing button - click it.  

10. The name of the new action that you pro-
grammed should appear in the palette. Be sure 
that the boxes in the left column of the palette are 
checked and that the floppy disk symbols in the 
right column are not.

11. You have completed the batching action need-
ed to quickly convert your photos from Color to 
Grayscale. You will not have to do this again.

12. To use this action at another time, open 
Photoshop®. On the menu bar go to “File”, select 
“Automate” and then select “Batch… .”  Under 
“Play”, under the Default Actions select the the 
action “Color to Grayscale.” Under “Source” is 
“Folder”, select “Choose” and choose the fold-
er that contains the photos you want to batch.  
Under Choose, no boxes in “Source” are selected 
(checked).  Under “Destination” select “Folder”,  
select “Choose” and and select a pre-existing fold-
er or name a new folder on your desktop to which 
you want to save them.  Check the box Override 
Action “Save As” commands. The file name is 
“Document Name + extension.”  Select “Stop for 
Errors.”  Select “OK” and the batching starts.  

The photos will flash open and close quickly, too 
quickly to see, yet your new Grayscale photos will 
be saved in the folder you set up to receive them. 
Later, you can use these photos to place into your 
QuarkXPress® or InDesign® pages. Then you will 
burn a CD with these photos to submit to us.

BAtCHING PHOtOS FOR ACtIONS (e.g. converting color to grayscale)
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Note: All of the photos that you wish to batch must 
be in one folder and you will create a new folder 
on your desktop for your converted photos. Using 
one photo from your folder, you are about to pro-
gram your application to perform an Action that 
you can repeat over and over.

1.  Open Photoshop®. 

2. On the menu bar go to “Window”and select 
“Actions.”

3. On the menu bar go to “File” and select “Open” 
and open just one of the photos you want to 
batch.

4. On the “Actions Palette”, top right hand side 
is a small arrowhead pointing to the right.  Click 
on this and select “New Action… .”  Name your 
action “Re-sizing Portraits” and click   “Record.” 

5.  Look at the bottom of the “Action” palette. The 
“Record” button should be red confirming that 
recording is in progress.  

6. With the photo open, go to the menu bar under 
“Image” and select “Image Size.” At the bottom 
left side check all three- “Scale Styles”, “Constrain 
Proportions”, and “Resample Image.” Be sure 
“Resample Image” is set to “Bicubic.” Under 
“Document Size” type in the layout width or height 
you desire (in picas). Whichever you select, the 
other will be the constrained proportion. (If you key 
the width, the height must be equal to or greater 
than the layout size.) Next, type “300” into the pix-
els/inch resolution. Select “OK” and a re-sized ver-
sion of the photo will replace the original.

7. On the menu bar go to “File” and select “Save 
as… .” The original name of the photo should 
appear, don’t change it, yet select  the format 
“JPEG.” At this point you can make a new folder on 
your desktop in which to save the photo(s). Click 
“Save.” When the next window pops up key “11” 

next to “Quality” under “Image Options” and click 
“Baseline Standard” under “Format Options.”
 Click “OK.”

8. Close the photo.

9. Return to the “Actions Palette.” Look at the bot-
tom left corner next to the red record button and 
you will see a square box. That is the stop record-
ing button - click it.  

10. The name of the new action that you pro-
grammed should appear in the palette. Be sure 
that the boxes in the left column of the palette are 
checked and that the floppy disk symbols are not.

11. You have completed the batching action need-
ed to quickly resize your portraits before placing 
them into the page designs. You will not have to 
do this again.

12. To use this action at another time, open 
Photoshop®. On the menu bar go to “File”, select 
“Automate” and then select “Batch… .”  Under 
“Play”, under the Default Actions select the the 
action “Re-Sizing Portraits.” Under “Source” is 
“Folder”, select “Choose” and choose the fold-
er that contains the photos you want to batch.  
Under Choose, no boxes in “Source” are selected 
(checked).  Under “Destination” select “Folder”,  
select “Choose” and and select a pre-existing fold-
er or name a new folder on your desktop to which 
you want to save them.  Check the box Override 
Action “Save As” commands. The file name is 
“Document Name + extension.”  Select “Stop for 
Errors.”  Select “OK” and the batching starts.  

The photos will flash open and close quickly, too 
quickly to see, yet your new re-sized photos will 
be saved in the folder you set up to receive them. 
Later, you can use these photos to place into your 
QuarkXPress® or InDesign® pages. Then you will 
burn a new CD with these photos to submit to us.

BAtCHING PORtRAItS FOR ACtIONS (e.g. re-sizing before placing)
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PRINTING
Printing on the endsheet is very popular. The 

various rating services like to see the creativity that 
goes into playing out the theme on the endsheet 
while working in the table of contents. The design 
can be just text, or graphics can be added that 
mimic page one or the dividers of your book. Even 
photographs look good printed on the endsheet. 

Most staffs with printed endsheets choose a 
white or light colored paper and print the text/ art/
photos in a darker color. More that one color can 
be printed on the endsheet. If your front endsheet 
is being used to print the table of contents, then the 
colophon, staff listing or acknowledgements can 
be printed on the back endsheet. Many staffs like 
to leave a lot of space open on the back endsheet 
for signatures, and we can help by designing just a 
subtle reminder of the theme in words or graphics 
for the back endsheet. 

Some schools have a tradition of printing the 
senior class photo on the endsheet,  with a serious 

shot on the front and a more casual or even a silly 
shot on the back. We urge you to use a professional 
photographer to take this photo and to provide an 
8 X 10 print. Make sure that the crowd is posed 
with a break in the middle so that when the photo 
is printed on the endsheet no one’s face appears in 
the fold of the book.

There is an additional charge for printing the 
endsheet of your book. 

EMBOSSING
Do you have a school seal die on file at Cooke? If 

you do, you might like to emboss the endsheet with 
the seal. An embossing die presses the impression 
of the art into the paper to create raised and low-
ered areas of the design.

If you prefer a new design, then there is an addi-
tional cost to cut a new embossing die as well as 
the running charge for actually embossing the end-
sheet.

MEtHODS OF PRODUCtION

Endsheets are the heavy, uncoated paper stock 
that are glued between the front cover and page 
one, and between the back cover and the last page 
of your book. They attach the text pages (or the 
“guts”) to the cover by being glued between the 
two. Cooke offers a selection of more than two-doz-
en colors from which to choose. The colors range 
from deep, dark solids to water marked parchment 
to lightly speckled stock.

You can use the front endsheets to continue the 
development of the theme from the cover as well as 
to print the table of contents, freeing up space with-
in the book for additional theme-related material. 

If you print the back endsheet, you can complete 

the theme with words or graphics that have been 
introduced throughout the book. The back end-
sheet can also include the colophon, staff listing or 
acknowledgements.

Choose the endsheet to coordinate or comple-
ment the color that you choose for the cover. If you 
do not print the endsheet, you can choose from any 
of the colors we offer. If you are printing the end-
sheet, you will want to start with a light color and 
print a darker color of ink on it. 

Remember that at some schools, it is tradition to 
have friends sign the endsheet. If that’s the case at 
your school, you will need to choose a color that 
will easily show handwriting in pen. 

ChOOSiNg ENdShEETS
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If you never have enough room for signatures, or 
don’t want people writing all over your yearbook 
pages, consider purchasing eight additional blank 
pages that can be bound in the back of your book. 
The paper stock has a soft, uncoated finish so that 
you can sign on it in pen and it will not smear like the 

high-gloss pages used for the inside of your book. 
The decision to include these pages must be made 

by early December when the cover is designed and 
ordered so that the cover can be made large enough 
to accomodate these extra pages. 

AUtOGRAPH PAGES

DIE-CUTTING
A shape can be cut into the right hand side of 

the front endsheet to reveal a part of a photograph 
or art on page one of your book. We have some 
standard shapes in stock (circles, squares, etc.), 
but if you want a fancier shape - a mascot or per-

haps an outline of a building, a die must be made 
with a cutting edge to cut through the heavyweight 
paper. 

There is an additional cost for making the die, as 
well as the running charge for actually die-cutting 
the endsheet.
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• The book title and year should appear on the 
front cover in an attractive, readable type style.
• The book title, year, school and volume number 
should appear on the spine. Some rating services 
require the city and state, too.

• The cover design should be neat, attractive and 
should introduce the theme.
• The cover colors should be attractive and help to 
create a favorable impression of the book.

RULES FOR COVERS

MEtHODS OF PRODUCtION

Flat-Foil Stamping: We apply silver, gold or colored 
foil by impressing the design with a stamping die.
Embossing: Heavy-weight base material is used. 
Embossing dies are hand-cut brass “relief” dies 
used to raise up the design or type. Then foil can 
be applied to the embossings. Embossed areas can 
also be top-stamped or screened.

Lithographing (or print): You can print type, pho-
tos or art on the cover in one or multiple colors. We 
plastic-coat the printing to seal the inks and protect 
the cover.
Silk-screening: A colored, silk-screen paint is 
applied to a base material of any color.

MAtERIALS

The cover can be manufactured in Skivertex®, linen 
or vellum cloth, Sturdite® or burlap.

Your representative will show you swatches of the 
exact colors and grains on cover decision days.

The student’s reaction to the cover determines his/her opinion of the whole book. Capture the reader’s 
attention immediately by making the cover as exciting as possible.

ExtRAS

Some of the cover extras you can order are: addi-
tional applications of color, holographic foils, met-
allay, grain, overtone (rub), film laminate (high 
gloss, gloss and matte), and name stamping.

NOTE: See “Preparing Deadlines” to determine 
when your cover material and name stamping 
decisions are due.

ChOOSiNg COvErS
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You can personalize your yearbooks by stamping 
individual names on the front cover in gold or sil-
ver foil. The cost for this is $4.00 per book.

Name-stamping lists must be submitted before the 
holiday/Christmas break.

HOw tO SUBMIt YOUR NAME-StAMPING LISt

• Your name-stamping list must be supplied to your 
representative on disk keyed in Microsoft® Word®. 
• Tag the first five lines of the file with your school’s 
name, job number, file name, software name and 
version, and the number of names to be stamped 

on your books.
• Key each name on a line by itself in capital and 
lower case letters in “First name Last name” format.
• Do not print more that one column on a page.
• Provide a printout of your file with your disk.

CONVERtING NAMES IN MICROSOFt® ExCEL® tO MICROSOFt® wORD®

Follow these instructions if you were given the name-
stamping list as a Microsoft® Excel® document.
• Open the Excel file in Microsoft® Word®.
• Select all the names in the table (do not select 
any blank lines that are not in the table). Under the 
“Table” menu go to “Convert” and select “Convert 
Table to Text... .”
• If the names are in one column as a table, select 

“Paragraph” in the “Separate Text With” box, and 
hit “OK.”
• If the names are in three or four columns as a 
table (first name in one column, middle initial 
in one column, last name in one column) select 
“Other“ in the “Separate Text With” box. Key in 
one space and hit “OK.”
• Resave and print.

tRANSPOSING NAMES IN MICROSOFt® wORD®

Follow these instructions if you were given the 
name-stamping list keyed last name first and first 
name last.
• Open the file in Word.
• Under the “Edit” menu go to “Replace... .” Find 
all the commas and replace with nothing. This will 
leave you with last name, space, first name, space, 
middle initial, paragraph mark.
• Go to “Replace...” again. Find all the spaces and 
replace with a tab mark (ˆt). This will leave you 
with last name, tab, first name, tab, middle initial, 
paragraph mark.
• Select all the names (not including the five-line 
heading). Under the “Table” menu go to “Convert” 
and select “Convert Text to Table... .”

• In the dialog box that appears, enter “3” in the 
“Number of Columns” box, and in the “Separate 
Text By” box choose “Tab Marks.” This will put 
your names in three columns – last name, first 
name, middle initial.
• Select the first column, then cut and paste it 
behind the last column. Now the last names are in 
the last column.
• Select all three columns. Under the “Table” menu  
go to “Convert” and select “Convert Table to Text... .”
• In the dialog box that appears, select “Other” 
in the “Separate Text With” box, and key in one 
space. Hit “OK.” Your names should be in the cor-
rect order now.
• Resave and print.

NAME STAMpiNg
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You will receive a laser-print proof of your cover 
and  endsheet design. Foil-stamped or em bossed 
covers are presented as black and white rendi-
tions of the dies to be made. Usually only the front 
cover and backbone are presented. Print ed or silk-
screened covers and endsheets are presented as 
full spreads and print ed in the planned colors. The 
proof may be slightly reduced to enable in struc-

tions and print ing leg ends to appear. Check the 
proof for ac cu ra cy. This is the only op por tu ni ty to 
make chang es before stamp ing dies, em boss ing 
dies, or print ing plates are made. Write a sep a rate 
note about any nec es sary chang es and sta ple the 
note to the proof. If there are no chang es, in di cate 
so on the proof cover sheet. Return the proof on 
time as directed on the instructions.

COVER OR ENDSHEEt PROOFS

PAGE PROOFS

Laser proofs are final page proofs of the type, 
photographs and lay outs sub mit ted for your book. 
The proofs are presented in print er spreads, mean-
ing that most facing pages appear together. Books 
with trim siz es of 8-1/2” X 11” or small er ap pear at 
full size on the proofs. Books with larg er trim sizes 
may be slight ly re duced to fit on the proof paper. 

Pages submitted for printing with second color 
or nat u ral color photographs are presented in the 
colors. They are produced on our TECHTRONICS 
color laser printer. Second color inks are emulated 
by the color printer. While these colors are in the 
correct position and show the appropriate separa-
tions, the shades of the color may not be exact.

INStRUCtIONS FOR MAKING CHANGES

• Check all proofs for accuracy and completeness 
against a copy of the material that you supplied to 
us with the deadlines. Be sure to verify the relation-
ship of photographs to captions. Mark any changes 
to the proofs in RED by circling incorrect words 
and drawing a line out to the margin where you 
should reprint the entire word or phrase as you 
wish it to appear. Circle and strike through with a 
red pen any words or lines that you are de let ing. 
Prepare a word pro cess ing file and sub mit a disk 
and printout for any late or missing copy that you 
are submitting with the proofs. Provide any miss-

ing or replacement photographs and cross out any 
pho tographs to be re moved. Print portrait names 
across the faces in the proofs if you are juxtaposi-
tioning names. 
• Au thor’s Al ter ations to the proofs are $3.00 per 
line of copy, $9.75 each to move or recrop an exist-
ing photograph, $15.00 each for new or replace-
ment pho to graphs and $18.00 for a new spread.
• Protect your delivery date by returning all proofs to 
Cooke Publishing Company by the date due. A late 
return may adversely affect your pro duc tion sched-
ule. Please contact us if there will be any delay.

ChECkiNg prOOFS
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Here are some suggestions and information for 
our new advisers, and reminders for our veterans.

Normal deliveries are scheduled between 8:00 
a.m. and 4:00 p.m. While we can confirm your 
delivery date, we cannot project the exact time. 
Please be prepared and patient. The yearbooks are 
delivered via a local trucking firm that we have 
used for more than fifty years. The driver has the 
adviser’s name and usually he will check in at the 
main office or at the loading entrance. The books 
are packed bulk, in boxes, packed on skids, and the 
driver will off-load them at the delivery entrance. 
Students or school personnel should be available to 

take them to any specific room. If anyone is avail-
able to to help off-load the books, then the driver 
can move on to the next school more quickly. The 
boxes are marked with the school name and title 
and the quantity of books inside. If any boxes have 
personalized books, it is noted on the boxes and 
on the delivery receipt. Be sure to count all cartons 
and packages before signing for them, or instruct 
anyone else who will be accepting  the delivery on 
your behalf to check the details. We suggest that 
anyone signing for you should notify you immedi-
ately that the books are in the building.

wHAt tO ExPECt

IF YOU NEED MORE BOOKS

We do inspect the books before packing. 
However, if we deliver any damaged books please 
set them aside, contact us, and we will replace 
them. If you have a personalized book with a prob-
lem, then hold it and distribute a good book to the 
student with the instruction that he/she return it to 
you after securing signatures. We will personalize 

the student’s new copy and return it to the school/ 
student.

Notify us if you need more books and we will 
check our inventory. Sometimes we produce extra 
books to distribute as reference or theme samples, 
and they may be available for sale at a cost that is 
less expensive than the unit rate. 

dELivEry NOTES



We take everything personally

607 louis drive • warminster, pa • 18974 • phone: 215.957.2701 • fax: 215.957.2705

www.cookebooks.com

COOKE
PUBLISHING 
COMPANY

PAGE 37

Columbia Scholastic Press Association (CSPA)
Columbia University
Mail Code 5711
New York, NY 10027-6902
Tel. (212) 854-9400
Fax. (212) 854-9401
Email. cspa@columbia.edu
http://www.columbia.edu/cu/cspa/

American Scholastic Press Association (ASPA)
PO Box 4400 
College Point, NY 11356 
Fax. (718) 747-0099 
Email. asa@asan.com 
http://www.asan.com/asa/aspa1.htm

National Scholastic Press Association (NSPA)
Associated Collegiate Press
2221 University Ave SE, Suite 121
Minneapolis, MN 55414
Tel. (612) 625-8335
Fax. (612) 626-0720
http://www.studentpress.journ.umn.edu/nspa/
 

Pennsylvania School Press Association (PSPA) 
Pennsylvania Newspaper Association
3899 North Front Street
Harrisburg, PA 17110-1563
Tel. (717) 703-3007
Fax. (717) 703-3008
http://www.paschoolpress.org

Maryland Scholastic Press Association (MSPA)
1117 Journalism Bldg.
University of Maryland
College Park, MD 20742-7111
Tel. (301) 405-8321
Fax. (301) 314-9166
http://www.journalism.umd.edu/mspa/

Garden State Scholastic Press Association 
(GSSPA)
78 Lincoln Street
Jersey City, NJ 07307 
Email. info@gsspa.org

ASSOCIAtIONS

OtHER RESOURCES OF INtERESt

Associated Press World Wide Photos
for High School Yearbooks
Tel. (212) 621-7946

Student Press Law Center
(Legal Advice for Student Publications)
1101 Wilson Boulevard
Suite 1100
Arlington, VA 22209
Tel. (703) 807-1904
http://www.splc.org/

Poynter’s High School Journalism Guide
http://www.poynter.org/subject.asp?id=59

High School Journalism
www.highschooljournalism.org

Columbia Journalism Review
http://www.cjr.org/

rEFErENCES & rESOUrCES
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Newslink
http://newslink.org/

Selected Journalism Schools
http://bailiwick.lib.uiowa.edu/journalism/j-
schools.html

Writer’s Write Journalism Schools
http://www.writerswrite.com/journalism/jschool.
htm

PA Department of Education
http://www.pde.state.pa.us//

PA School Profiles
http://www.paprofiles.org/

PA College Profiles
http://www.pdehighered.state.pa.us/higher/
cwp/view.asp?a=11&Q=114124&pde_
internetNav=%7C

Recycling in PA Schools
http://www.dep.state.pa.us/dep/deputate/airwaste/
wm/recycle/School/school.htm

High School in the State of NJ
http://www.directoryofschools.com/high-schools/
new-jersey.htm

New Jersey High Schools and NJ High School Links
http://www.metrojersey.com/highschools.htm

Top 10 Tips for Great Pictures
http://www.kodak.com/eknec/PageQuerier.
jhtml?pq-path=317&pq-locale=en_US&_reques-
tid=631

Top Ten Digital Photography Tips
http://www.macdevcenter.com/pub/a/
mac/2002/10/22/digi_photo_tips.html

Student Curriculum in Photography
http://www.scphoto.com/

Photo Course: The home of the best and most 
affordable textbooks on digital photography
http://www.photocourse.com/

Digital Photography Review
http://www.dpreview.com/

Short Courses: Famous for its books on digital 
cameras and digital photography. 
http://www.shortcourses.com/

PeachPit Press 
(Quality How to Computer Books)
http://www.peachpit.com/

Adobe® InDesign® Tutorials
http://www.softwaretrainingtutorials.com/inde-
sign-cs.php 

http://www.adobe.com/designcenter/video_work-
shop/ 

QuarkXPress® Tutorials
http://www.sketchpad.net/quark.htm
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The number one cause of missed deadlines is 
poor communication. One way to clear up the 
communication cloud and avoid misunderstand-
ing is to write everything down.

You can invent forms for yearbook photo and 
story assignments that include a request, due date, 
contact person, and any other necessary instruc-
tion. Included in this Manual are form examples 
that you can use “as is” or adapt to your needs.

Forms give the assignments an official touch and 
are written proof of their existence. The assigned 
student knows exactly what is to be done, by when, 
and has a physical reminder. The editor or adviser, 
who keeps a copy of the assignment, has effectively 
delegated and can follow-up on the student’s prog-

ress. Writing due dates on the master calendar will 
allow other staff members to support the student in 
completing the task.

Also included is a sample of a “Weekly Work 
Schedule” form to assist you in planning and track-
ing assignments at weekly staff meetings. Asking 
students to fill out forms for “What I plan to do/
What I accomplished” this week is another recom-
mended practice which teaches goal-setting and 
time management.

Look at the weak areas of your staff and invent 
forms to manage them. It may seem like extra paper-
work at first, but in the long run it saves work and 
avoids the “falling through the cracks” syndrome.

SAMpLE FOrMS
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Layout Pages Prepared on Computer   

  _____  Column style is followed consistently throughout sections

  _____  All copy and photo blocks fall on whole picas

  _____  Copy is pasted accurately (copy columns line up, captions are anchored next to 

photos)

  _____  Copy is consistent in size, weight, and typeface (stylesheets were used)

  _____  Headlines are consistent in size, spacing and capitalization

  _____  Folios are placed accurately 1.5 picas from the trim

  _____  Second color is used consistently

  _____  Page numbers in page palette are accurate (use numbering and sections options)

  _____  Blank pages are removed from file

  _____  Digital photos are in grayscale if printing in black and white

  _____  Digital photos were cropped and saved as JPEG files in Adobe® Photoshop®

  _____  Digital photos are named properly. Example - 002-01

  _____  Digital photos are placed and linked properly

  _____  Files are named properly. Example - 002-003(1603), 134-135(1603)

Comments: _______________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

dEAdLiNE ChECkLiST
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Writing ______ Stories are written in past tense

 ______ Quotes are used throughout essays

 ______ Essays begin with an interesting lead

 ______ Gag captions are not used

 ______ Captions are at least two sentences (first – present tense, second – past tense)

 ______ Row designations in group captions are consistent throughout the book

 ______ Headlines follow dummy style

Comments: ______________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________
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School ______________________________________________________________

Scheduled Deadline Date____________ Date Material Was Received ________

Number of Pages Due _______________ Number of Pages Received __________

Pages received with this deadline have been indicated on the grid to the left.

Notes: ______________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________

____________________________________________________________________  

____________________________________________________________________

dEAdLiNE CONFirMATiON
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Name: Mr. / Mrs. / Ms. / Br. / Sr. / Rev. / Dr.  ____________________________________________________________________

Please list the college(s)/university(ies) you attended and the degree you received from each, starting with the most recent.

College/University _____________________________  Degree ___________________________________________________

College/University _____________________________  Degree ___________________________________________________

College/University _____________________________  Degree ___________________________________________________

College/University _____________________________  Degree ___________________________________________________

College/University _____________________________  Degree ___________________________________________________

Please list the courses you teach this year.

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________ 

Please list the sports, clubs, activities and organizations in which you are involved with your appropriate title (e.g. coach, 
sponsor, adviser, etc.).

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________ 

Please return this form to the yearbook office by _________________________________________________________________

dirECTOry SUrvEy FACULTy
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Name ____________________________________________________________________________________________________

Address  __________________________________________________________________________________________________

__________________________________________________________________________________________________________

Quote/Thank you __________________________________________________________________________________________

__________________________________________________________________________________________________________

__________________________________________________________________________________________________________

The following is a list of school sponsored activities and sports. Please circle the years in which you were involved. List any 
positions held (captain, president, editor, etc.) after the appropriate year.

Art Club 9 _________________ 10 ________________  11 ________________  12 ______________

Baseball 9 _________________ 10 ________________  11 ________________  12 ______________

Basketball (Boys’) 9 _________________ 10 ________________  11 ________________  12 ______________

Basketball (Girls’) 9 _________________ 10 ________________  11 ________________  12 ______________

Bowling 9 _________________ 10 ________________  11 ________________  12 ______________

Cheerleading 9 _________________ 10 ________________  11 ________________  12 ______________

Chess Club 9 _________________ 10 ________________  11 ________________  12 ______________

Chorus 9 _________________ 10 ________________  11 ________________  12 ______________

Community Service Corps 9 _________________ 10 ________________  11 ________________  12 ______________

Computer Club 9 _________________ 10 ________________  11 ________________  12 ______________

Concert Band 9 _________________ 10 ________________  11 ________________  12 ______________

Cross Country 9 _________________ 10 ________________  11 ________________  12 ______________

Cultural Diversity Club 9 _________________ 10 ________________  11 ________________  12 ______________

Dance Troupe 9 _________________ 10 ________________  11 ________________  12 ______________

Drama 9 _________________ 10 ________________  11 ________________  12 ______________

Forensics 9 _________________ 10 ________________  11 ________________  12 ______________

Field Hockey 9 _________________ 10 ________________  11 ________________  12 ______________

Football 9 _________________ 10 ________________  11 ________________  12 ______________

This is a sample form to follow when making your own senior directory form. Continue your list alphabetically. 
Use the front and back side of one piece of paper. We recommend distributing and collecting forms during homeroom.

dirECTOry SUrvEy SENiOrS
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Name: ________________________________________________Homeroom: _______________________

Section:_______________________________________________Editor: ____________________________

Due Date: _____________________________________________Number of Photos on Spread: ________

Number of Vertical Photos Needed: ___________Number of Horizontal Photos Needed: ___________

Subject/Angle: ___________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Dominant Photo Should Express: ___________________________________________________________

________________________________________________________________________________________

The Date and Time of the Event: ____________________________________________________________

The Location of the Event: _________________________________________________________________ 

Contacts: _______________________________________________________________________________

________________________________________________________________________________________

Attach this form to your contact sheet along with any other information (caption details of who, what, 

where, when, etc.) and return to ___________________________________________________________ 

phOTO ASSigNMENT
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Name: ________________________________________________ Homeroom: _______________________

Section: _______________________________________________ Editor: ____________________________

Due Date: _____________________________________________ Number of Words: _________________

Subject/Angle: ____________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

Headline Idea: ____________________________________________________________________________

Contacts: ________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

NOTE: Use an interesting lead. Write in the past tense. Use direct quotes from students and faculty. Key 

your story in Microsoft Word and save to the yearbook computer/server. Attach this sheet to a 

printout of your story and return  to ___________________________________________________  

STOry ASSigNMENT
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When submitting your pagination and theme plans, please fill in the following forms and return them 
along with the pagination ladder.

Name of your school: _____________________________________________________________________

Name of your yearbook: ___________________________________________________________________

Theme phrase for your yearbook: ___________________________________________________________

Explain why you chose this theme: __________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Explain how you will develop this theme in the opening section of your yearbook (stories and photographs): 

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

List any graphic ideas that relate to the theme that you would like to see used throughout your yearbook: 

________________________________________________________________________________________

________________________________________________________________________________________

Provide other ideas as to how you want to carry your theme throughout your yearbook (cover, endsheets, 
color use, feature ideas, etc.):_______________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________ 
 

ThEME SUBMiSSiON
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Please make a photocopy of this page for every section of your yearbook.

Divider section name (ex. Sports): ____________________________________________________________

Divider phrase related to theme:  _____________________________________________________________

Explain how you will develop this theme phrase in the copy on this layout. (Remember, stories need to 
grow from/incorporate the theme and theme phrase):

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

List the kinds of items and/or features you want to see on your layouts in this section of your yearbook: __

  ________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

State the approximate number of words you want the various copy boxes to hold: ___________________

State your preference of dominant photo orientation (horizontal or vertical):

_________________________________________________________________________________________

Other information for Cooke’s Art Department: _________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________  

Attach any layout ideas (sketches, photocopies, etc.) you have for this section.
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Date: ____________________________________________________________________________________

Goals for the Week: _______________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

 Staff Member Name This Week’s Assignment

wEEkLy wOrk SChEdULE


